Chapter 363

Mixed Models Tests for Slope-Interaction in a 2×2 Factorial 3-Level Hierarchical Design with Fixed Slopes (Level-3 Randomization)

Introduction

This procedure calculates power and sample size for a three-level hierarchical mixed model which is randomized at the third level. The associated longitudinal study uses a 2-by-2 factorial design with two binary factors X and Z, each with two possible values (0 and 1). This results in four treatment arms. The goal of the study is to test whether the slopes of subjects across time are different from what would be expected if the effect of the two factors were additive. That is, one wants to test the three-way interaction between the two binary factors and time.

In most cases, this design is called a repeated measures design. The classic example is a study in which the level-2 units are subjects which are nested in level-3 units (e.g., classes, clinics, or hospitals). The level-1 units are time points at which measurements are taken. This factor is nested in the level-2 units.

This procedure is for longitudinal studies in which each subject is measured two or more times.

In this case of level-3 randomization, each level-3 unit is randomly assigned to one of the four treatments combinations. All level-1 and level-2 units within a specific level-3 unit receive the same interventions (treatment).

All subjects in a treatment group are assumed to have the same (fixed) slope.
Technical Details

Our formulation comes from Ahn, Heo, and Zhang (2015), chapter 6, section 6.6.1, pages 218-222. The hierarchical mixed model that is adopted is

\[
Y_{ijk} = \beta_0 + \delta_X X_{ijk} + \delta_Z Z_{ijk} + \delta_T T_{ijk} + \delta_{XZ} X_{ijk} Z_{ijk} + \delta_{XT} X_{ijk} T_{ijk} + \delta_{ZT} Z_{ijk} T_{ijk} + \delta_{XZT} X_{ijk} Z_{ijk} T_{ijk} + u_i + u_{j(i)} + e_{ijk}
\]

where

- \(Y_{ijk}\) is the continuous response of the \(k^{th}\) level-1 unit, within the \(j^{th}\) level-2 unit, within the \(i^{th}\) level-3 unit.
- \(X_{ijk}\) is an indicator variable that is equal to “1” if the \(j^{th}\) level-2 unit is assigned to receive intervention X and “0” otherwise. Thus, \(X_{ijk} = X_j\) for all \(i\) and \(k\).
- \(Z_{ijk}\) is an indicator variable that is equal to “1” if the \(j^{th}\) level-2 unit is assigned to receive intervention Z and “0” otherwise. Thus, \(Z_{ijk} = Z_j\) for all \(i\) and \(k\).
- \(\beta_0\) is the fixed intercept.
- \(\delta_X\) is the treatment effect of factor X.
- \(\delta_Z\) is the treatment effect of factor Z.
- \(\delta_{XZ}\) is the interaction effect of factors X and Z.
- \(\delta_{XT}\) is the interaction effect of factors X and Z.
- \(\delta_{ZT}\) is the interaction effect of factors X and Z.
- \(\delta_{XZT}\) is the 3-way interaction effect of X, Z, and time. The is the coefficient of interest.
- \(u_i\) is the level-3 random intercept effect for the \(i^{th}\) level-3 unit. It is distributed as \(N(0, \sigma_3^2)\).
- \(u_{j(i)}\) is the level-2 random intercept effect for the \(j(i)^{th}\) level-2 unit. It is distributed as \(N(0, \sigma_2^2)\).
- \(e_{ijk}\) is the level-1 random intercept effect that is distributed as \(N(0, \sigma_e^2)\).
- \(\sigma^2\) is the variance of \(Y\) when slopes are fixed, where \(\sigma^2 = \sigma_3^2 + \sigma_2^2 + \sigma_e^2\).
- \(\rho_1\) is the correlation among level-1 units which are in a particular level-2 unit.
- \(\rho_2\) is the correlation among level-2 units which are in a particular level-3 unit.
- \(C_{0,0}\) is the number of level-3 units for which \(X = 0\) and \(Z = 0\).
- \(C_{0,1}\) is the number of level-3 units for which \(X = 0\) and \(Z = 1\).
- \(C_{1,0}\) is the number of level-3 units for which \(X = 1\) and \(Z = 0\).
- \(C_{1,1}\) is the number of level-3 units for which \(X = 1\) and \(Z = 1\).
- \(K\) is the average number of level-2 units (subjects) per level-3 unit.
- \(M\) is the number of level-1 units per level-2 unit. It is the number of measurement times.

The test of significance of the product \(X_{ijk} Z_{ijk} T_{ijk}\) is the interaction effect of X, Z, and Time. This is the test statistic of interest. It tests whether the subject-specific slopes behave the same across all treatment combinations.

Assume that \(\delta_{XZT}\) is to be tested using a Wald test. The statistical hypotheses are \(H_0: \delta_{XZT} = 0\) vs. \(H_a: \delta_{XZT} \neq 0\).
The power is calculated using

\[
Power = \Phi \left( \frac{\delta_{XZT}}{\sigma} \right) \sqrt{\frac{C_{0,0}KM \text{Var}(T)}{\frac{1}{C_{0,0}} + \frac{1}{C_{1,1}} + \frac{1}{C_{1,0}} + \frac{1}{C_{0,1}}}} - \Phi(1 - \alpha/2),
\]

where \( f = 1 - \rho_1 \) and \( \text{Var}(T) = \sum_{j=1}^{M} (T_j - T)^2 / M. \)

### Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

### Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

#### Solve For

This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are \( \delta_{XZT} \) (Three-Way Interaction), Power, \( C_0 \), \( K \), or \( M \).

Note that the value selected here always appears as the vertical axis on the charts.

The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary search is made using an iterative procedure until an appropriate value is found. This search considers integer values of \( C_0 \), \( K \), and \( M \) only.

#### Power and Alpha

##### Power

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5.

##### Alpha

This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected.

Values must be between zero and one. Usually, the value of 0.05 is used for alpha and this has become a standard. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
Sample Size – Number of Level-1, Level-2, and Level-3 Units

**C00 (Group 00 Count \((X=0, Z=0)\))**

This is the number of level-3 units in group 00, the \((0,0)\) cell in a 2-by-2 factorial table of \(X\) and \(Z\). The total sample size (number of level-1 units) of this group is \(C00 \times K \times M\).

Note that this is a longitudinal study.

Each of the factors \(X\) and \(Z\) have two levels: 0 (no intervention) and 1 (intervention). Thus, in this group in which \(X = 0\) and \(Z = 0\), neither of the interventions occur. Hence, this is called the control group.

This value must be a positive integer.

You can enter a list of values such as "10 20 30". A separate analysis will be run for each element in the list.

**C01 (Group 01 Count \((X=0, Z=1)\))**

This is the number of level-3 units in group 01, the \((0,1)\) cell in a 2-by-2 factorial table of \(X\) and \(Z\). The total sample size (number of level-1 units) of this group is equal to \(C01 \times K \times M\).

Note that this is a longitudinal study.

Each of the factors \(X\) and \(Z\) have two levels: 0 (no intervention) and 1 (intervention). Thus, in this group in which \(X = 0\) and \(Z = 1\), an intervention occurs for the second factor but not the first.

**Using Multiples of C00**

If you simply want a multiple of the value for group 00, enter the multiple followed by "C00", with no blanks. If you want to use \(C00\) directly, you do not have to enter a leading "1".

For example, all of the following are valid entries: 10C00 2C00 0.5C00 C00.

You can use a list of values such as "10 20 30" or "C00 2C00 3C00".

**C10 (Group 01 Count \((X=1, Z=0)\))**

This is the number of level-3 units in group 10, the \((1,0)\) cell in a 2-by-2 factorial table of \(X\) and \(Z\). The total sample size (number of level-1 units) of this group is equal to \(C10 \times K \times M\).

Note that this is a longitudinal study.

Each of the factors \(X\) and \(Z\) have two levels: 0 (no intervention) and 1 (intervention). Thus, in this group in which \(X = 1\) and \(Z = 0\), an intervention occurs for the first factor but not the second.

**Using Multiples of C00**

If you simply want a multiple of the value for group 00, enter the multiple followed by "C00", with no blanks. If you want to use \(C00\) directly, you do not have to enter a leading "1".

For example, all of the following are valid entries: 10C00 2C00 0.5C00 C00.

You can use a list of values such as "10 20 30" or "C00 2C00 3C00".
C11 (Group 11 Count (X=1, Z=1))

This is the number of level-3 units in group 11, the (1,1) cell in a 2-by-2 factorial table of X and Z. The total sample size (number of level-1 units) of this group is equal to C11 × K × M.

Note that this is a longitudinal study.

Each of the factors X and Z have two levels: 0 (no intervention) and 1 (intervention). Thus, in this group in which X = 1 and Z = 1, both interventions occur.

Using Multiples of C00

If you simply want a multiple of the value for group 00, enter the multiple followed by "C00", with no blanks. If you want to use C00 directly, you do not have to enter a leading "1".

For example, all of the following are valid entries: 10C00 2C00 0.5C00 C00.

You can use a list of values such as "10 20 30" or "C00 2C00 3C00".

K (Level-2 Units Per Level-3 Unit)

This is the number of level-2 units (usually subjects or patients) per level-3 unit. For example, if the three levels are repeated measures in subjects in doctors, this level is the number of subjects per doctor.

This value must be a positive number that is at least 1.

You can use a list of values such as "10 15 20". A separate analysis will be run for each element in the list.

M (Level-1 Unit Count Per Level-2 Unit)

This is the average number of level-1 units (e.g., subjects) per level-2 unit (e.g., class) in all four groups.

This value must be a positive number that is at least 1. It can be a decimal (fractional) number such as '2.7'.

List

You can use a list of values such as "10 15 20". A separate analysis will be run for each element in the list.

Effect Size

δ_{XYT} (Three-Way Interaction)

Enter one or more values for δ_{xzt}, the regression coefficient of the Xijk x Zijk x Tijk term in the mixed model. It is this interaction among the four group slopes at which the study is to be powered. That is, the power is the probability of detecting an interaction of at least this amount. This value is not the true interaction. Rather, it is the interaction that you want to be able to detect.

Slope Interaction

Suppose we define β_{xz} to be the slope of the level-1 units in the (x,z) cell in a 2-by-2 factorial table. For example, β_{10} is the slope of the data in the (1,0) cell in a 2-by-2 factorial table of X and Z.

This interaction is a difference of slope differences. It is constructed as the difference between the two slope differences (β_{11} - β_{10}) and (β_{01} - β_{00}). It is the failure of the two interventions to act independently of each other.

δ_{xzt} can be any non-zero value (positive or negative). Since this procedure uses a two-sided test statistic, you will get the same result with either positive or negative values.
Syntax

You can enter a single value such as

10

or a series of values such as

10  20  30

or

5 to 50 by 5

When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

\( \sigma \) (Standard Deviation)

Enter the standard deviation of \( Y_{ijk} \) assuming the slopes are fixed. You might obtain variance component estimates for the quantities used to form \( \sigma^2 \) from previous studies or a pilot study.

Definition of \( \sigma^2 \)

For clarity, in the following we are using square-brackets to enclose the subscripts.

Let

\[
V(e) = \text{Variance of error term, } e[jjk].
\]

\[
V(2) = \text{Variance of level-2 random intercept, } u[j(i)].
\]

\[
V(3) = \text{Variance of level-3 random intercept, } u[i].
\]

\( \sigma^2 \) is defined as \( \sigma^2 = V(3) + V(2) + V(e) \).

Range

\( \sigma \) must be a positive number.

Syntax

You can enter a single value such as 5 or a series of values such as 1 3 5 7 9 or 1 to 10 by 1. When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

Help for Estimating \( \sigma \)

Press the small '\( \sigma \)' button to the right to obtain calculation options for estimating the standard deviation.

\( \rho_1 \) (Correlation Among Level 1 Units)

This is the correlation of each pair of level 1 units in a particular level 2 unit.

Possible values are from 0 to just below 1. Typical values are between 0.0001 and 0.5.

You may enter a single value or a list of values.
Example 1 – Calculating Power

Suppose that a three-level hierarchical design is planned in which there will be two interventions. Each intervention will be whether one of two drugs is administered. There will be five measurements per subject and the four treatments will be applied to level-3 units. A range of level-2 units are planned in each treatment group. The available level-3 units will be randomly assigned on one of the four groups.

The analysis will be a mixed model of continuous data using the model given earlier in this chapter. The goal of the study is to test the regression coefficient of the XZT interaction. The following parameter settings are to be used for the power analysis: $\delta_{XZT} = 3; \sigma = 9.8; \rho_1 = 0.1; K = 5$ or $10; M = 5; \alpha = 0.05$; and $C_{00} = C_{01} = C_{10} = C_{11} = 5$ to $20$ by $5$. Find the power of each combination of parameter settings.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for Slope-Int’n in a 2×2 Fact. 3-Lvl Hier. Design with Fixed Slopes (Lvl-3 Rand.) procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

Option Value
Design Tab
Solve For .................................................... Power
Alpha.................................................................. 0.05
C00 (Group 00 Count (X=0, Z=0))................ 5 10 15 20
C01 (Group 01 Count (X=0, Z=1))................. C00
C10 (Group 10 Count (X=1, Z=0)).................. C00
C11 (Group 11 Count (X=1, Z=1))................. C00
K (Level 2 Units Per Level-3 Unit).................. 5 10
M (Level 1 Units Per Level-2 Unit)................... 5
$\delta_{XZT}$ (Three-Way Interaction).................. 3
$\sigma$ (Standard Deviation).......................... 9.8
$\rho_1$ (Correlation Among Level-1 Units)......... 0.1

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>Total Lvl 1 Cnt</th>
<th>Grp00 Lvl 3 Cnt</th>
<th>Grp01 Lvl 3 Cnt</th>
<th>Grp10 Lvl 3 Cnt</th>
<th>Grp11 Lvl 3 Cnt</th>
<th>Lvl 2 Cnt</th>
<th>Lvl 1 Cnt</th>
<th>2 × 2 Interaction Cnt</th>
<th>Std Dev</th>
<th>ICC Lvl-1 Units</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.7228</td>
<td>500</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>3.00</td>
<td>9.80</td>
<td>0.100</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9503</td>
<td>1000</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>10</td>
<td>5</td>
<td>3.00</td>
<td>9.80</td>
<td>0.100</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9503</td>
<td>1000</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>5</td>
<td>3.00</td>
<td>9.80</td>
<td>0.100</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9992</td>
<td>2000</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>10</td>
<td>5</td>
<td>3.00</td>
<td>9.80</td>
<td>0.100</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9992</td>
<td>2000</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>5</td>
<td>5</td>
<td>3.00</td>
<td>9.80</td>
<td>0.100</td>
<td>0.050</td>
</tr>
<tr>
<td>1.0000</td>
<td>4000</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>20</td>
<td>10</td>
<td>5</td>
<td>3.00</td>
<td>9.80</td>
<td>0.100</td>
<td>0.050</td>
</tr>
</tbody>
</table>

© NCSS, LLC. All Rights Reserved.
References

Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the total number of level-1 units in the study.
C00 (Group 00 Count (X=0, Z=0)) is the number of level-3 units in Group 00 (X=0 and Z=0).
C01 (Group 01 Count (X=0, Z=1)) is the number of level-3 units in Group 01 (X=0 and Z=1).
C10 (Group 10 Count (X=1, Z=0)) is the number of level-3 units in Group 10 (X=1 and Z=0).
C11 (Group 11 Count (X=1, Z=1)) is the number of level-3 units in Group 11 (X=1 and Z=1).
K is the number of level-2 units (subjects) per level-3 unit.
M is the number of level-1 units per level-2 unit (i.e., the number of time points).
δxzτ is the 3-way interaction among the subject-specific slopes (β11 - β10) - (β01 - β00) at which the power is calculated.
σ is the standard deviation of the Yijk assuming a fixed-slope model.
ρ is the correlation among level-1 units in a particular level-2 unit.
Alpha is the probability of rejecting a true null hypothesis, that is, rejecting when the means are actually equal.

Summary Statements
A total sample size of 500 observations, were obtained by sampling 5 level-3 units in group 00, 5 level-3 units in group 01, 5 level-3 units in group 10, and 5 level-3 units in group 11, and then sampling 5 level-2 units (subjects) per level-3 unit, and then sampling 5 level-1 units (repeated measurements) per level-2 unit. This sample achieves 72% power to detect a three-way interaction among the subject-specific slopes of at least 3.00. This 2×2 interaction was formed from the four group slopes across time using the following formula: δxzτ = (β11 - β10) - (β01 - β00). The standard deviation of subjects is 9.80. The intraclass correlation coefficient of level-1 units is 0.100. A test based on a mixed-model analysis assuming fixed slopes is anticipated at a significance level of 0.050.

This report shows the power for each of the scenarios.

Plots Section

These plots show the power for the various parameter settings.
Example 2 – Calculating Sample Size (C00)

Continuing with the last example, suppose the researchers want to determine the value of C00 needed to achieve 90% power for both values of M.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for Slope-Int’n in a 2×2 Fact. 3-Lvl Hier. Design with Fixed Slopes (Lvl-3 Rand.) procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>C00 (Group 00 Count (X=0, Z=0))</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>C01 (Group 01 Count (X=0, Z=1))</td>
<td>C00</td>
</tr>
<tr>
<td>C10 (Group 10 Count (X=1, Z=0))</td>
<td>C00</td>
</tr>
<tr>
<td>C11 (Group 11 Count (X=1, Z=1))</td>
<td>C00</td>
</tr>
<tr>
<td>K (Level 2 Units Per Level-3 Unit)</td>
<td>5 10</td>
</tr>
<tr>
<td>M (Level 1 Units Per Level-2 Unit)</td>
<td>5</td>
</tr>
<tr>
<td>δxzt (Three-Way Interaction)</td>
<td>3</td>
</tr>
<tr>
<td>σ (Standard Deviation)</td>
<td>9.8</td>
</tr>
<tr>
<td>ρ1 (Correlation Among Level-1 Units)</td>
<td>0.1</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Numeric Results for an Interaction in a 2×2 Factorial</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Lvl 1</td>
</tr>
<tr>
<td>-------------</td>
</tr>
<tr>
<td>Power</td>
</tr>
<tr>
<td>0.9282</td>
</tr>
<tr>
<td>0.9503</td>
</tr>
</tbody>
</table>

This report shows the required C00 count for each of the scenarios.
Example 3 – Validation using Ahn, Heo, and Zhang (2015)

Ahn, Heo, and Zhang (2015) page 222 provide a table in which several scenarios are reported. We will validate this procedure by duplicating the first row. The following parameter settings are used for the power analysis: Power = 0.80; δxzt = 0.3; σ = 4; ρ1 = 0.1; M = 5; K = 8; and α = 0.05. The values of C00, C01, C10, C11 are found to be 63 and the resulting power is 0.801.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for Slope-Int’n in a 2×2 Fact. 3-Lvl Hier. Design with Fixed Slopes (Lvl-3 Rand.) procedure window. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

Option Value
Design Tab
Solve For ................................................... C00 (Group 00 Count (X=0, Z=0))
Power ........................................................ 0.80
Alpha ......................................................... 0.05
C01 (Group 01 Count (X=0, Z=1)) ................. C00
C10 (Group 10 Count (X=1, Z=0)) ................. C00
C11 (Group 11 Count (X=1, Z=1)) ................. C00
K (Level 2 Units Per Level-3 Unit) ................. 8
M (Level 1 Units Per Level-2 Unit) ................. 5
δxzt (Three-Way Interaction) ....................... 0.3
σ (Standard Deviation) .............................. 4
ρ1 (Correlation Among Level-1 Units) .......... 0.1

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Numeric Results for an Interaction in a 2×2 Factorial</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
</tr>
<tr>
<td>Total</td>
</tr>
<tr>
<td>Lvl 1</td>
</tr>
<tr>
<td>Lvl 1</td>
</tr>
<tr>
<td>Lvl 1</td>
</tr>
<tr>
<td>Lvl 1</td>
</tr>
<tr>
<td>Lvl 1</td>
</tr>
<tr>
<td>Lvl 1</td>
</tr>
<tr>
<td>Lvl 1</td>
</tr>
<tr>
<td>Lvl 1</td>
</tr>
<tr>
<td>Lvl 1</td>
</tr>
</tbody>
</table>

PASS also calculates C00 to be 63 and the power to be 0.8013.